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“The cover of a magazine should give

a pre-feeling of the contents that are
following,” says guest designer Gerwin
Schmidt. By reflecting the movement and
rhythm of the designs featured in this
issue, Schmidt follows through on this
concept.“l wanted to create a feeling of

a three-dimensional room, where two-
dimensional visuals are layered behind
each other and can change very fast”

The cover also reveals Schmidt's design
“playing rules”for this issue: the circles,
frames, and layers on this initial page are
recurring elements used across all his
feature story layouts.

ENHANCE ONSCREEN READING

To make sure you get the best PDF experience
while reading Adobe Magazine, make sure you've
enabled the Adobe® CoolType feature in your
Adobe® Reader® Preferences. Here's how:

- In Adobe Reader 7, select Adobe Reader >
Preferences > Page Display and check the
"Use CoolType"box.

« In Adobe Reader 8, select Edit > Preferences >
Page Display > Rendering > Smooth Text, then
choose “For Laptop/LCD Screens”from the
drop-down list.
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GUEST DESIGNER
GERWIN SCHMIDT STUDIO

This issue’s cover and feature stories have been
designed by Gerwin Schmidt and his partners, who
live and work in Munich, Germany. See complete bio.

Reading: Remote People, by Evelyn Waugh.

Watching: "My little daughter grow. | also love to
watch the changing seasons at my farmhouse near the
Bavarian Alps!

Creating: "A suitable lifestyle for my family, my office,
and my graphic design students at the State Academy
of Art and Design Stuttgart.

Pondering: "Everything that surrounds me. People,
media, information, systems, religions.”

CONTRIBUTORS

This issue’s creative ideas, inspirational art, and
practical techniques have been provided by:

« Leia Bell

- Seymour Chwast, The Push Pin Group
. Robert Frank

- Milton Glaser

- George Gruel, Odd Stick Studio

- Jianping He, Hesign

- Melk Imboden

- Anette Lenz

- Richard Lipton

- Oliver Meckes and Nicole Ottawa , Eye of Science
- Scott Robertson, Drawthrough

- Koichiro Tanaka, Projector

- Jonah Warren, FeedTank
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specifically to make viewers stop and think. And

that's why we decided to let the art—and the artists
themselves—do the talking. Make sure to check out the
stunning posters, then click on the audio button to hear
the artists speaking about their work.

"What color do | see? Which density could be the right
one? Do | feel movement or rhythm?”Based on this
thinking, Schmidt then develops a set of “systematic
playing rules”for his designs.

From the twists and turns of global issues

to the minute details of everyday life, the
world around us must always be recognized,
absorbed, and felt. Consider it the background
material for art and design.

It's precisely what we expect from our guest designers,

Gerwin Schmidt, our guest designer for this issue,
challenges us to remember this—and to keep our eyes,
minds, and hearts open.‘l think about everything that
surrounds me,’ says the Munich-based designer, who's
also a professor at the State Academy of Art and Design

Stuttgart. "People. Systems. Media. Religion. ..

The focus inevitably narrows when it's time to start

a project. And Schmidt approaches this conceptual
whittling with a meticulous process.”l think about the
structures and dynamics within the content,” he says.

who bring their introspective worldviews, personal
styles, and exacting professionalism to the pages of
this magazine. We count on their work to challenge our
personal ideas about design. And we hope, every once
in a while, that it'll inspire us to re-examine our own
perspectives on art and life.

DESIGN THAT PROVOKES

The designers featured in our Talent for Good story—
many of whom were suggested by Schmidt—rise to
this calling. Their provocative posters are designed

Original thinkers also stand out in our other stories.
Whether it's the playful interactive spaces created

by Jonah Warren of FeedTank, the experimental
techniques used by architectural illustrator Robert
Frank, or the wildly out-of-the-box UNIOLOCK website,
designed by Koichiro Tanaka of Projector, you'll find
enough design fodder to keep you thinking. At least
until the next issue of Adobe Magazine comes out. =

NEW THIS ISSUE
- Instructional
Spotlight page

- Audio story format
- Bonus Adobe® Bridge

Home content
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The play of imagination can take an infinite variety of shapes. You
can see it in concept designer Scott Robertson’s otherworldly land-
scape illustrations. You can find it in the radical process behind archi-
tectural illustrator Robert Frank’s traditional work. Or in the detailed
complexity of George Gruel's landscape lighting renderings. And it
boldly presents itself in the hyperreal scientific images created by
Nicole Ottawa and Oliver Meckes.

These artists have styles all their own, and yet they're bound by a

common spirit of experimentation. They play with media, with pro-

cess, with techniques, with art itself. And through this creative trial THE VISIONARY
and error, they've each gained their share of artistic enlighten- According to Scott Robertson, the work of a concept designer is to
ment—and digital imaging insight. “show the rest of us visions of places and things we’ve never seen

before.” Robertson should know. Working with clients as esoteric
as Kestrel bikes and as ubiquitous as Universal Studios, Robertson’s

industrial and concept designs have been giving shape to imagination
for over 17 years.

Sometimes, the designs are a reflection of his own unbridled ideas.
More often, they reflect a well-researched client need, as in the case
of the collectible cards Robertson recently designed for the Swype-
out Online Battle Racing game. The cards feature phantasmagoric

racecars that swoosh across asphalt in ribbons of metallic color, as
if they were plucked directly from a 9-year-old boy’s dreams. And, in
fact, they were. Kids in focus groups were shown car designs with
various proportions for wheelbase, overall body width and height.
“They told us which cars were the coolest,” says Robertson, who
used their opinions to shape his designs. Learn more about how he

created the cars.

But target audience approval and carefully detailed parameters are
all part of the game—especially on industrial design projects, which
often have strict engineering and functionality requirements. And
within this melding of project limitations and conceptual possibilities,
G_J Robertson often finds the sweet spot for his creativity. “When you
understand the parameters of a project, it frees you up,” he says.

Many of Robertson’s precise renderings start as loose marker sketches. . o
o You know where you can push the boundaries.
See the original image.
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TRADITION AND TECHNOLOGY

Robertson’s industrial and concept designs look as much like objects of art as items of commerce.
His artistic expertise stems from a well-honed background in traditional media combined

with a skillful use of digital tools like Google SketchUp, Autodesk Maya, Wacom tablets, Modo,
and Adobe® Photoshop® CS3.

Robertson typically starts with hand-drawn designs, which are all scanned into the computer and
brought into Photoshop at some point during his process. The actual digital turning point depends
on the medium. “Monochromatic renderings can sometimes be done just as fast with markers,”
he says. “But when I'm doing color renderings, | go straight to Photoshop.” Once there, Robertson
paints special effects into the renderings using a wide array of custom brushes. He also relies on
Clipping Path Layers, which allow him to easily paint gradations, such as reflected light, on top of
a shape. And while he relies on the technology to create precise renderings, his creative joy
typically comes early in the design process, when he’s sketching on paper, with a trusty marker
in hand. Learn how to create your own custom brushes.

Race creatures for Alien Race, Robertson’s next
Design Studio Press book, available in July 2008.

“When you understand a
project’s parameters, it frees
you up. You know where you
can push the boundaries.”
—Scott Robertson

ADOBE MAGAZINE FOR CREATIVE PROFESSIONALS

Concept bike designed for Robertson’s
Concept Design 1 book.
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http://www.sketchup.com
http://usa.autodesk.com/adsk/servlet/index?siteID=123112&id=7635018
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THE POET

For architectural illustrator Robert Frank, every step of the process
is digital—even his earliest rough concepts. But you'd never know
it by looking at his work. His illustrations all feature a soft, painterly
style, as if they were created on canvas with watercolors. While

SOPHISTICATION AND SUBTLETY

The trick is to get a traditional look while enjoying the benefits of an
all-digital workflow. Frank’s secret? Custom styles in Adobe Photo-
shop CS3. To create them, he draws textures by hand and paints on
watercolor paper. Then he scans this artwork into his computer and

ADOBE MAGAZINE FOR CREATIVE PROFESSIONALS

other illustrators use digital tools to create exacting, photorealistic brings it into the Photoshop CS3 Layer Styles dialog box, where it

renderings, Frank uses technology to “convey the poetry and becomes the basis for his custom styles.
atmosphere of each project.”

Frank’s illustrations have a crisp, computerized look at first. They
His style harkens back to the pre-digital days of architectural start as formeZ wireframes, with initial renderings and line drawings

illustrations done in watercolor, charcoal, pen, and ink. When digital created in Adobe® |llustrator®. The shift backwards, from technol-

rendering stormed the architectural world in the early 90s, this ogy to tradition, happens later in the process, when the illustrations

hand-drawn style became almost as obsolete as the drafting table. are imported into Photoshop. Frank paints every element of his

But even as paintbrushes were replaced by pixels, the old-guard rendering on a separate layer, uses the Photocopy and Smart Blur

art forms retained their relevance. “| think people started to miss filters to make the line work less crisp, and then applies his custom

the warmer look of traditional media,” says Frank. “And today, the styles to give the work a softer, watercolor look. “| can use the

direction seems to be turning back to a hand-drawn style.”

Gradient tools to create a perfect sky,” says Frank. “And then | can
run it through one of my custom styles and it breaks it up a little; it
gives it that imperfection.” Visit the Photoshop page on Adobe Bridge
Home to find out more about his technique.

And this is where the true artistry happens. “It’s all about experi-

menting,” says Frank, who never uses the standard watercolor filter

in his illustrations. “It looks canned,” he says. “But | can use the With an experimental combination of

Texturizer with the Sandstone filter and create a hand-painted effect Photoshop CS3 filters and custom styles,

that looks really natural. You have to go beyond the basic techniques.” Frank creates a hand-painted effect.

“It's all about experimenting.
You have to go beyond the basic
techniques.”

—Robert Frank
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THE REALIST

A background in traditional art also informs the work of landscape
lighting illustrator George Gruel. But in his industry, realism is king.
“We can't sell clients something that won’'t work,” says Gruel.

“I can make a front walkway look beautiful in Photoshop, but if it
can’t realistically be lit that way, then no one’s happy.” ’

Staying true to this goal of visual accuracy requires a keen under- “I can ma ke a fro nt Walk'

standing of the distinct effects of light on objects. And plants. “It’s all

about subtleties. It's about understanding how light filters through a Way l'OOk bea UtIfUl In ,
Magnolia with brown on the back of its leaves.” Such details can't be PhOtOShOp, but |f It can't
rendered accurately in 3D CAD, the tool of choice for many in the rea llSt'Ca lly be |.|t that Way

landscape lighting industry. “CAD just looks fake,” says Gruel, who

4 44
uses Adobe Photoshop to create ultra-realistic nighttime lighting th en no ones ha p py
mock-ups from ordinary daytime photos. —Geo rge G ru el.

LIGHT AND LAYERS

After removing any harsh shadows from the original image, Gruel lays
a warm yellow photo filter over the image to replicate the slight yellow
tint of incandescent light. He then creates a layer of black and lays it
over the image to create the nighttime scene. From there, Gruel can
mask individual landscape features in the image and use tools like the
Channel Mixer and the Color Range selection tool to adjust contrast

and paint the light, leaf by leaf if necessary. Learn more about Gruel's
technique.

“Sometimes, to get it right, I'll have more than 100 layers,” says Gruel.
“I'll have to add shadows that weren't in the original image, or change
shadows that were side-lit in daytime to show what they're going to
look like when they're down-lit at night,” says Gruel. “The creativity of
my work is in nuances like these. | paint with light.”

Gruel meticulously paints his nighttime landscape scenes in Photoshop.

See the original image.
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“Pelargonia™: A surprising—and much closer—
look at a Geranium leaf.

“Nature itself is art.”
—Oliver Meckes

THE HYPERREALISTS

For Eye of Science duo Oliver Meckes and Nicole Ottawa, digital
imaging isn’t about illustrating an alternate reality. It's about revealing
a hidden one. With Ottawa’s training as a biologist and Meckes’ experi-
ence as a photographer, Eye of Science creates images that explore
everything from bacteria to botany—all while showcasing the intrinsic
beauty of “the world beyond human vision.”

In this world, a verdant, prickly hillside is actually a Geranium leaf.
And a sci-fi alien landscape is a close-up view of slime mold. “When
we put specimens under the Scanning Electron Microscope, we
discover amazing structures,” says Meckes. “Nature itself is art.”

COMPOSITION AND COLORING

The creative process starts before Meckes and Ottawa even put the
specimen in the Scanning Electron Microscope. “We adjust the
specimen’s parts with forceps and use hairs to move the objects on a
specimen holder,” says Meckes, who works like a stylist to “arrange
the whole scene in microscale.”

After a specimen has been carefully prepared, it's placed into the
Scanning Electron Microscope, where it can be observed, rotated and
magnified up to 50,000 times its original size. From here, finding the
right object view—or composition—is a meticulous process. “Often,
we search for half a day to find the right angle,” says Meckes.

Once the scan has been made, Meckes and Ottawa transfer the image
data to their computer and import it into Photoshop, where the digital
coloring process begins. Meckes and Ottawa paint each element of the
image on a separate Alpha Channel, with some pictures needing up to
12 channels. After coloring the different alphas in the first scan, they
composite two more scans of the same object as Photoshop Layers to
create a single image with a “great impression of depth.”

“We use color as a creative and harmonious tool to achieve beauty,”
says Ottawa. The duo stays true to the specimen’s original colors—
when possible. Some bacterias are smaller than a wavelength of light,
which means they have no color information. “With these specimens,
we are free,” says Ottawa, who uses established scientific color
codes—and a touch of artistic license—to make color choices. “We try
to find the right balance between scientific investigation and artistic
beauty in all of our work,” says Ottawa. “Because digital imaging
should always tell the truth.” =

Kimberly Grob is the editor of Adobe Magazine.

ADOBE MAGAZINE FOR CREATIVE PROFESSIONALS

Images from Science 2008: Call for Entries
Science and art come together in this
international juried photography show,
sponsored by The School of Photographic
Arts & Sciences at the Rochester Institute
of Technology and Adobe. Submit
scientific images from oceanography, ge-
ology, biology, engineering, medicine,
physics, or other related disciplines

before February 28, 2008. Find out more.

“Trichia dec. var. olivacea”: A new perspective on

mold—slime mold fruiting bodies, to be exact.
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ART AND IMAGING IN A 3D WORLD

How do you create the world’s coolest collectible racecar cards? |4
For Scott Robertson, it started by getting inside the automotive mind |5
of the pre-teen boy. From there, the big kids started revving their en- | ¢
gines—and building 3D photographic illustrations that nearly zoom |7
off the cardboard. | 8
9
HERE'S HOW THEY DID IT: 10

1. Conducted focus group research. We showed kids cars in different
shapes and proportions,” says Robertson. “And we watched for the
ones that they kept coming back to.”

2. Made a chassis in SketchUp. Made a 3D model of the wheels and
frame proportions. Printed an image of the chassis.

3. Did line drawings by hand over the SketchUp chassis. Scanned
line drawings and added values to show the transitional forms.

4. Built 3D models in Maya. The drawings were then sent to Fuel
Industries, a Canadian game development company, where they
were imported into Maya. The Maya 3D model of the car was then
built directly over Robertson’s drawing.

5. Prestaged the 3D illustration. Fuel Industries sent turntable
animations of each model back to Robertson’s studio for approval of
the final design. The collectible card illustrations were prestaged in
Maya or Modo to establish each illustration’s composition, general
lighting, and color—as well as its specific game functions and
weapons.

6. Output the 3D color rendering to Adobe Photoshop. Lighting
effects, weapons, wheel spins, and blurring techniques were all
painted by hand in Photoshop using a variety of custom brushes

10 Simple Photoshop Secrets created to easily indicate visual effects such as smoke and flames.

The artists in this story share even more 7. Composite backgrounds in Photoshop. 2D backgrounds were
tips and tricks on the Photoshop page of Adobe painted and composited into the final renderings using Photoshop.
Bridge Home, accessible from any

Adobe® Creative Suite® 3 application. > 1 - “This project was really fun at the end,” says Robertson. “We got to

be photographers in a 3D world.”
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NEW INTERACTIVE SPACES . . . . .
FEEDTANK’S JONAH WARREN TALKS ABOUT CREATING ENGAGING, INTERACTIVE SPECTACLES
. . . THAT THRILL AUDIENCES—AND CLIENTS. BY DAVID WOMACK

1
2
3
4
5
6
7
8
9
1
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Jonah Warren and Steven Sanborn of New York-based FeedTank build public interactive
experiences that encourage people to act creatively: They've designed digital dance
floors, new musical instruments, and digital graffiti tools. In the process, they've also
created new platforms for brands to reach out to a young, media-savvy audience that’s
increasingly resistant to traditional advertising.

Take their Dance Floor Moves project, for instance. Step into it and blocks of light scatter
and then snap back into place in response to your moves as you boogie to the beat. This
project has been installed in a hotel lobby, a clothing boutique, and a Toyota-sponsored
gallery. For FeedTank, working with brands is a way to gain exposure for their work
and fund future experiments. For companies, associating their brands with innovative
projects generates a positive buzz that stays with their audience far longer than a 15-
second TV spot.

FeedTank also creates original projects that bring brands to life. Working with motion-
graphics firm Trollback+Company, FeedTank created an interactive video installation
for Ask.com that was projected onto the 40-foot screen at the new The IAC Building in
Manhattan. The projection dynamically pulls data from the Ask.com site and presents

it in three dimensions, giving viewers an exciting new perspective on the information. In Dance Floor Moves, blocks of light scatter the millisecond anyone moves.
Many of FeedTank’s projects take input from one medium, transform it digitally, and

output it as another medium. A gesture becomes a pattern. A shape becomes a sound. m_/

The key is that this transformation occurs instantaneously. In order to make the illusion Watch a demo.

work, the designers create elaborate combinations of hardware, software, and original
code, sometimes integrating video cameras and Adobe® Flash® animation. Only a
few years out of school, Warren and Sanborn have built a successful business by doing
what they love, proving the new truism: Make it cool and business will follow.

Jonah Warren, FeedTank co-founder.
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How did FeedTank start?

FeedTank started about three years ago with a thesis project of mine called Unencum-
bered Full Body Interaction in Video Games. | had a gallery show to exhibit the project,
but needed another interactive piece for the space. | invited a friend, Steven Sanborn,
to collaborate. This lead to another collaboration, Dance Floor Moves. We wanted to
make a project so simple and obvious that people walking by on the street could in-
stantly understand it and engage with it. So we projected a bunch of colored squares
down onto the sidewalk. When you move through the squares they disperse and fly
around and then they snap back into place behind you. We projected it onto the side-
walk every night for a week and got an incredible response. People loved it. We posted
some videos of the project online and they got passed along and people started con-
tacting us. That's how FeedTank was born.

Do all your projects involve physical interactions?

We're always trying to get away from the monitor and mouse and experimenting with new
forms of interaction. We want to get people up on their feet and moving around. This
means that our projects have to be simple and intuitive enough so you can walk up and
start playing, but then you have to jump around and really play to make it fun. | feel like
we ask a lot of our users in terms of participation, but not in terms of learning rules.

One thing that's interesting about your projects is that you tend to steer away from

offline metaphors.

Right, there are a whole bunch of computer games based on offline scenarios—there’s a
snowboarding game where you're leaning left and right, and a basketball game that tries
to mimic dribbling. But | think those games are ultimately disappointing. Snowboarding
isn’t just about leaning left or right. | think simpler games that don’t try to replicate
another experience are more successful because the user doesn’t come with expectations.
They learn the system on the fly. “There’s an abstract block, | can kick it and it moves.”
| think there’s more potential in exploring interactive space on its own terms.

How did you get interested in games?

| got into games because | was really interested in experimenting with interaction. | felt
that gaming was the best space to play in. With games, you're not tied to any
constraints or existing design vocabularies—Ilike the need to use menus or tabs, for
example. Games can be more about the exploration of interactive space.

One of your most recent projects was for the largest high-definition video wall in the
world—the 11-foot-high, 120-foot-long screen in the IAC building, which was designed
by Frank Gehry. Tell me about that project.

This project was a little different because instead of designing new interactions, we were
concentrating on how to display data. We worked primarily with Trollback+Company, who
were hired to create the content. Trollback specializes in motion graphics and they
wanted some pieces that use live data feeds—that’s where we came in. We worked
with Trollbdck to come up with ideas, which was a great collaboration. Each of the
three pieces we created relates to an aspect of IAC’s business.

For example, we created a module for ASK.com that animates their dynamic news
feeds. Huge headlines that span 40 feet zoom towards you and seem to fly off the
screen. It's very dramatic.

How did you make this work?

We created a graphics library in C++ and pulled in the data from the Ask.com website.
Based on the data that came in, we would draw it in a special font, turn that letterform
into a 3D object—this allows us to really play with the data. For example, we can turn

it or animate it and scale it.

| really like the project because it plays with ideas of scale. We'd worked with
companies incorporating their visual assets—Ilogos and such—nbut this was the first
time that we created an original project based on some aspect of the client’s
business—in this case, Ask.com and the idea of information.

A video wall for the IAC building

in New York City pulls live data from
ASK.com and projects it

as 40-foot-wide headlines.
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“WE ASK A LOT OF OUR
USERS IN TERMS OF
PARTICIPATION, BUT NOT
IN TERMS OF

LEARNING RULES.”
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It seems like a lot of your work begins as self-initiated projects. You have this great
idea and you build it and then a company comes along who wants to use it to promote

their product.
That’s about it. We make money to work on new ideas.

How do these projects help build the brand of your clients?
Well, no one is paying attention to the 30-second advertisement any more, so compa-

nies need to find new ways to reach out to audiences, especially young audiences.
Rather than pushing their product directly, many companies are choosing to create a
positive experience for customers so that they will have something they can talk about
with their friends. That's where we come in. We create an environment in which the
product can be experienced in a positive way.

How do you know if a project is going to be successful?

Well, if I'm interested in it and want to spend a lot of time playing around with it then
that's a good sign. But that’s just the beginning. There are other things we look for. For
example, if a project is in a public space it’s often important that more than one person
be able to interact with it at a time. One of the reasons that our interactive dance floor
works so well is that it can be experienced by groups of people. You jump around and
interact with the other people using it. It kind of breaks the ice. It’s ironic—the dance
floor is probably our simplest project, but we get the most business from it. Some of our

other projects that we've really worked hard on have not been as commercially success-
ful—at least not yet.

detected so the blocks don’t move. It’s difficult and it takes real patience, but they were
able to cross the floor without triggering any of the blocks. And they thought that was
the real goal of the game. We hadn’t even considered this—so it was really exciting.
That’s the kind of thing that can happen when you create an open system.

What do you think you'll be doing in 10 years?

[ don’t know really. | try to focus more on the creative process rather than a future goal
I'd like to achieve. | really love putting these projects together and | try to focus on my
work. | think the future will take care of itself. m

David Womack writes and consults on digital technology. He is the co-author of Becoming
a Digital Designer and the editor of Adobe ThinkTank, an online journal about trends
and issues in the field.
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Talk a little bit more about how you test your work.

“IF APROJECTISINA
PUBLIC SPACE, IT'S OFTEN
IMPORTANT THAT MORE
THAN ONE PERSON BE ABLE
TO INTERACT WITH

IT AT ATIME.”

You can have a hypothesis about how people are going to interact with a system but
until people start using it you really have no idea as to how it's going to turn out. Play
testing is such a crucial part of the process. You make a little bit, test it with users, and
then go back and make a little more. | like figuring out new ideas and getting them to
the place where other people can enjoy them. Seeing the unexpected things that people
do with the things you make is my favorite part of the process.

For example, the interactive floor uses an algorithm for detecting movement that
compares images. If there’s enough difference between images it considers that move-
ment and it moves the blocks. A family wandered in and they started walking very
slowly across the floor. Now, if you move slowly enough then the change doesn’t get

Add motion and interactivity to your work.

e Get animation tips for Adobe Flash, lllustrator,
and Photoshop on our Spotlight page.

¢ Find more tutorials in Adobe Bridge Home,
accessible from any CS3 application.
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HOW IT'S DONE
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Export video and FLV files from
Adobe® Premiere® Pro.

|
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19

Learn about various export settings, such as
settings for video quality, file size, and

compression. Watch the tutorial on the Adobe
Premiere Pro page of Adobe Bridge Home,
accessible from any Adobe Creative Suite 3
application.

ONLINE ORIGINALITY FROM UNIQLOCK

DANCING BETWEEN VIDEO AND FLASH

Dance Floor Moves is one of FeedTank’s most basic projects—and yet it's the one that
brings in the most business. From a boutique hotel lobby in Sweden to a Toyota-
sponsored gallery in Los Angeles, this interactive installation brings smiles to the
faces of everyone who hits the dance floor—and street-cred coolness to the brands
who decide to play with it.

HERE'S HOW IT WORKS:

1. A dance floor space is chosen and illuminated with a blacklight. This provides a
source of light without ruining the ambiance. “You can also use an infrared light,” says
Warren. “But black lights look cooler.”

2. CCTV cameras capture footage from the dance floor. CCTV security video cameras
are hung above the floor space and positioned carefully to capture footage only from
the designated dance floor area. CCTV cameras have several advantages over regular
video cameras or webcams: They work better in low lighting, have good image quality,
and—nbest of all—they’re much cheaper. The fact that the footage is in black-and-
white doesn’t matter, because this is just the input device, not for display.

3. The live video footage is fed to computer. Warren uses VidCap freeware to capture
footage.

4. Video frames are compared and movement is detected. Using the Bitmap Data
Action Script, Adobe Flash can access a video frame’s pixel values and compare it to
the pixel values of the next frame. If the difference is above a specified threshold, it's
categorized as movement.

5. Every movement triggers an Adobe Flash animation. Blocks of light scatter and then
snap back into place in response to the movement.

6. A projector hung above the dance floor redirects the animation downward. The other
option is to have the projector on a shelf and use an angled mirror to redirect the
animation downward.

Out on the dance floor, blocks of light scatter the millisecond anyone moves. And that’s
key to the experience. Even a slight delay would break the connection between what
people are doing and what they're seeing—especially when the dance floor is crowded
and blocks are flying everywhere.

{ >
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The power of a poster to inquire, to compel, to pro-
voke, and to fundraise is illustrated beautifully by
seven diverse designers, representing some of the
most influential cultural voices in the world. View
their work and listen to their views on creative in-
spiration, civic responsibility, and doing good for
the sheer sake of doing good. By Todd Scurr
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“Most posters are done to be discarded after their use. This particular poster
has been around since 1968, because the message still makes a point for all
of us today.” —Seymour Chwast
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“It’s a way to be present; a way to say I
we are here, we are part of this city, we
are part of the visual expression of this

city.” —Anette Lenz
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Lenz commentary
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“End Bad Breath” by Seymour Chwast: Made in the 1960s, “Rwanda” by Anette Lenz and Vincent Perrottet: Photography
woodcut was used as the technique, and then the piece was and various layers done in Adobe lllustrator and Photoshop,

printed offset. then silk screened.
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“It was important for me to speak to people who were interested in art, since
the poster was made for an art exhibition. But also, it was important to me
as a photographer.” —Melk Imboden
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“It’s about the influence of European posters in
Japan, and about German theater poster design in
the 70s.” —Gerwin Schmidt
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Schmidt commentary
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Imboden commentary
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“European Cultural Posters” by Gerwin Schmidt: A composite of
photographs was created first, then refined using simple tools in
Adobe Photoshop.

“Kunstmarkt” by Melk Imboden: Hand drawing began this process,
followed by manipulation and refinement in Adobe Photoshop.
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“l am interested in tracing Western typographies in Asian

landscapes. The two cultures have absolutely meshed with my
interests.” —Jianping He

“About a dozen different artists designed posters for the event,
which also included a bike ride. They sold the posters after-
wards and raised over $26,000 for the MS Society.” —Leia Bell He commentary

“New Graphic” by Jianping He: Began concepting with photo-
graphic ideas, and then moved to Adobe Photoshop for manipu-
lation and refinement.=

g )

The opinions expressed in this story are not necessarily the opinions of Adobe.

Bell commentary

“Screens ‘n Spokes” by Leia Bell: All color separations were done by hand, layers were scanned
into Adobe Photoshop for refinement, then silk screened.
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“The graphic problem is always the same: How do you enter into people’s
consciousness? Where is the crack in the surface that enables you to get

into visibility?” —Milton Glaser

“Darfur” by Milton Glaser: A composite
of photography, typography, and drawn
scratches manipulated and refined in
Adobe Photoshop.

» 1 5

THEIRC.ORG
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According to renowned graphic designer
Milton Glaser, “There is no way to behave
ethically in the world without paying some
attention to the genocide in Darfur.”

This poster, intended to increase social
awareness, appeared throughout New York
City from November 2006 to February 2007.

Given the glut of disturbing images from
Sudan, Glaser hoped to penetrate the immunity
of the audience by speaking a language that
is human rather than ethnic.

A layered composite of photography, typo-
graphy, and drawing, this poster was created
in Adobe lllustrator and Photoshop for the
International Rescue Committee (IRC).

i ONLINE ORIGINALITY FROM UNIQLOCK

HERE’S HOW HE CREATED IT:

1. Glaser and his team started with a photo-
graph of a dark-skinned human hand.

2. Using Adobe Photoshop, each finger on
the photograph was copied into different
layers and re-colored in Adobe Photoshop
using the Hue and Contrast tools.

3. The Fade Opacity Gradient was used to
smoothly transition the fingers back on to the
original hand.

4. Natural colored fingernails from the
original hand were cut and pasted on to their
respective fingers. The Vertical Opacity tool
was used to ensure seamless pasting.

5. The finished hand was silhouetted.

6. The typographic lines were started in
Adobe lllustrator as vector art. The hand-drawn
scratches were scanned in, cleaned up in
Adobe Photoshop and, because they had a
transparent background, could be overlaid on
the type.

The end impact is a concept that connects
the audience to two abiding truths: that
genealogically we all trace back to Africa
and, that beyond the exterior differences we
often preoccupy ourselves with, we are
ultimately a single, interconnected species
sharing the same familial need for compassion,
action, and peace.

See more of Milton Glaser’s work.
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T.S. Eliot writes that between the idea and
the reality falls the shadow. For the creative
mind, this shadow lLlurks suspiciously, threat-
ening to suppress the next inspired idea. It
can be an all-too-familiar place, rendering
a wasteland of unfulfilled inspiration. When
artists can complete the creative process to
fully execute an original idea, then they
have realized success. Every once in a while,
their ideas avert the shadow and bask in the
spotlight of reality.

On the web, technical Llimitations can be the
shadow between a creative idea and its ultimate
reality. But Uniqlo's UNIQLOCK website is
proof that uncompromised creativity can thrive

within a world of technological restrictions.
AlLL while selling cashmere sweaters.

STYLISH FASHION, SAVVY MARKETING

Uniqlo is accustomed to reaping the benefits of
their creative risks. A Japanese manufacturer
and retailer of casual cool clothing, the
Uniglo brand embodies the ultra-contemporary,
hip attitude of Japan. From the web to store
windows, Uniqlo believes in an experiential
presentation of dits product that combines
creativity, stylish fashion, and savvy mar-
keting. Before the UNIQLOCK site, Uniqlo was
pushing the envelope with microsites Like
Uniglo Mixplay and Uniglo Explorer, created

by interactive design pioneer Yugo Nakamura.

Online videos and music:
peppy by day, soothing at night.

» AWAKENING THE WEB
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A real-time clock,

is displayed

@l

set to Tokyo time,

in between video sequences.

Their new UNIQLOCK site, designed by Tokyo-

based Projector, pushes ever further. It's
not a watered-down version of an original idea,
but rather a seamless, beautiful execution
of it. Best of all, it delivers a mutually
beneficial experience for the designers who
created it, the client that funded it, and
the audiences all over the world who've
become hooked on it.

Conceptual artistry with quirky yet uncom-

and
the
The choreographed videos of young

video original,

soundtrack

plicated sequences an

mesmerizing are centerpiece

of the site.

women in ordinary day-to-day settings are
set to music that's Lively and cheerful by
day, quiet and soothing by night. Integrated

subtly but persistently into the music, a wood
percussion tocks along with the beat, keeping
Like This
multimedia experience alone would be capti-

time an ever—-present metronome.

vating. But the real-time clock, interjected

seamlessly between video clips, catapults the
site into the realm of true originality.

how the real-time clock and video sequences

Learn

were integrated.
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CREATIVITY FOR EVERYONE'S SAKE

Along with the site
the

latest offer-

conceptual innovation,

delivers mass appreciation. For smart

consumer seeking out Uniglo's

ings in cashmere sweaters, the site is a hip

presentation of a product and its brand. For

those seeking a more intimate connection,
there's the site's World UNIQLOCK page. By
allowing visitors to Llink their personal

blogs to the UNIQLOCK site and set their own
local-time UNIQLOCKS via a
ever—-growing community
itself.

simple sign-on,
it offers a worldwide,

that's as diverse as the web

"Each audience has a unique relationship with

the site," says Koichiro Tanaka, Creative
Director at Projector. "But there's one common
thread. We want every person who experiences

the site to feel an emotional connectivity."

TECHNOLOGY FOR HUMANITY'S SAKE
And
creative hands—-that helps deliver the site's
It starts with the
intimate and elegant videos produced for
At midnight,
woman fall asleep with her knitting basket,
At midday,

it's the use of technology—-in very capable

strong sense of humanity.
185
the site. viewers might watch a

soothed by a Llullaby. they'll see

a trio of women dancing jauntily around a
classroom, fueled by a happy, productive
tune. To make these full-screen videos play

video optimization had to be
The videos were encoded
compressed 4.5
imported into Adobe Flash, where the

effortlessly,
carefully considered.

and using Sorenson Squeeze

and then
frame rate was set at 12 frames per second.
This lower fps setting helped to keep file sizes

down. Learn more about the video optimization

process.
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This strong sense of humanity is also revealed-
and greatly expanded-with the World UNIQLOCK,
which gives any site visitor access to the
personal blogs of more than 14,300 UNIQLOCK
visitors. By clicking on a city on the world
map, visitors can meet a web designer in Zurich,
a scientist in Perth, or a hipster in Glasgow
who claims "an appreciation of the world of
style over substance.” The Llist of World
UNIQLOCKers stretches beyond 1imagination.
It's all there for the taking, but it's not
a controlled experience; how visitors choose
to interact is entirely up to them.

"People want to talk. And they want to hear
from others who they can relate to," says
Tanaka. "The place where these conversations
occur most online are social media such as blogs
and social networking sites. So we created a
medium where UNIQLOCK users and the Uniglo brand
could be connected. And this is the heart of the
experience: not the multimedia website or screen-
saver, but the dinteractive blog widget that
allows people to connect."”

This widget—-created with a combination of XML,
JavaScript, and CGI technology, and animated
in Flash-is the engine workhorse behind the
compelling website. But 41it's the <creative
execution—-and the original thinking-that pro-
vides the allure. "The technology powering

these experiences is 1invisible," says Tanaka.
"It's used only to make the site's emotional
expression visible. And that, I believe, is
where the breakthrough of the UNIQLOCK tech-

nology really is."

The World UNIQLOCK allows visitors to
Link their personal blogs to the site and
set their own local-time UNIQLOCKS.

» AWAKENING THE WEB
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ENVISIONING A NEW REALITY

Technology 1is changing daily. And Koichiro
Tanaka recognizes that maintaining focus on
the future is a necessity. When asked about
what's next for Uniqlo, Tanaka seems to be
somewhere between idea and reality. "I'd Llike
to develop a new form of branded communica-
tion that combines the digital experience
and the physical experience." Just remember,
what may seem Llike a lofty idea today, can
become the reality of tomorrow.s

Jennifer Jackson is a freelance writer for
magazines and corporate clients.

Site visitors can access

the personal blogs of more
than 14,300 people from

around the world.
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BRIDGING CREATIVITY AND TECHNOLOGY WITH A HERE'S HOW IT ALL CAME TOGETHER:
TICKING CLOCK

1. 185 five—-second video sequences were created.
The ever—-ticking clock of the UNIQLOCK web- Each sequence was compressed for the web
site started as a creative 1idea. Projector using Sorenson Squeeze 4.5, then 1imported
figured that by wusing the <clock display into Adobe Flash. Learn to import video files

between video sequences, viewers would be into Adobe Flash.
engaged, Llooking to see what would happen 2.In Adobe Flash, the frame rate was set at
next. But in a brilliant melding of artistic 12 frames per second to help keep the file
concept and technical genius, the five-second sizes down. Learn more about frame rates 1in
clock dinterval also gave the full-screen Flash animations.
videos time to re-lLoad, allowing UNIQLOCK to 3.A real-time clock was integrated into the

play the videos endlessly and seamlessly. animation, which alternated between the five-
second video sequences and a five-second
clock interval.

4. The website's original score, created by
Japanese pop artist Fantastic Plastic Machine,

was imported into Adobe Flash and synchronized
with the ticking of the clock.
5.The site's performance was tested and

verified under different online conditions, 21
including Llow hardware and software specs s
and slower connection speeds. The final Flash |
files were then optimized to ensure all users 2
could enjoy the same experience. | 24
25
In the final presentation, the compelling s
videos and mesmerizing clock fluidly move to a
j—pop beat. It's the epitome of using technical
tools to realize creative vision—-and to create
emotional connectivity.
Find your own communities.
Discover popular design blogs and online communities on the product pages of Adobe
Bridge Home, accessible from any Adobe Creative Suite 3 application.
>
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http://en.wikipedia.org/wiki/Fantastic_Plastic_Machine_(musician)
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RicHARD LiPTON

By KEVIN PEASLEE

here’s one obvious reason why so many seem like machine-made, robotic approximations. penmanship book created by one George Bickham. hit. However, it didn’t meet all of its designer’s

designers turn to Bickham Script® Pro Bickham Script Pro, on the other hand, feels very, This discovery was the start of a crusade that would expectations.
for their script needs: elegance. Its swooping very real. last decades.
ornamental lines waltz with fluid, effortless “When Bickham was first released as a multiple
virtuosity across the page. A CALLIGRAPHIC COURSE “The book’s engraved script renderings became master font, many compromises were made,”

The fact that Bickham Script Pro captures the a model for everything I could not accomplish Lipton says. He would have to wait almost another

But there’s a less obvious, perhaps more feel of a pen on paper isn’t particularly surprising, as a calligrapher,” says Lipton. “The drama of decade before Bickham would reach its potential —
fundamental quality that sets Bickham Script Pro once you consider that its creator, well-known and the lettering mesmerized me for 20 years, until which was when OpenType® entered the picture.
apart. There’s something humanistic, even organic respected type designer Richard Lipton, worked I decided to try and replicate the spirit of these
about it, far more in keeping with the flow of ink as a calligrapher in his early years. It was during unparalleled engravings as a typeface.” TECHNOLOGY FOR TRADITION’S SAKE
being guided by steady, skilled fingers than a digital that nascent time in his professional life, while “With OpenType and its support for a widely
typeface. Appearing handwritten is the goal of all he was in his twenties, that he first got a copy of The resulting font, respectfully and rightfully expanded character set, restrictions were no longer
script typefaces, of course, but many of them still The Universal Penman, an influential 18th century called Bickham, came out in 1996. It was a big an issue,” says Lipton. In a twist, it was this
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cutting-edge technology that would allow him to ;’% i Z e, @J%é /(y%

more fully achieve the 18th century writing and %7 ,

engraving artistry of George Bickham. WWM {77/% a0 smcechh.
W lires o %MA eredoarors.”

“I had very specific ideas as to what I wanted to RICHARD L1PTON

add to Bickham Script Pro.” And what exactly did
he add? For starters, intelligence, variation, choice,
precision, and, yes, even more humanity.

The updated font had the incredibly deep character
set Lipton had hoped for, with more than 20
alternates per lower-case letter. But perhaps more
importantly, OpenType also allowed him to

have ligatures and glyphs automatically change
depending on context. For example, glyph exits
and entrances could subtly transform to ensure
complete fluidity and precision between letters and
even between words.

And with the ligature substitution intelligence
provided by OpenType, Lipton was better able

to channel the artistic letter variations of the old
masters he looked up to. Same-letter pairs could
vary, for example, eliminating the perfect, machine-
like repetition that too clearly says “made on a
computer.”

So with Bickham Script Pro, Lipton was finally able
to take his typeface to where he'd wanted it to be all
along—to a level that more accurately reflected the
brilliance and artistry found inside The Universal
Penman. “My goal for Bickham had been to be true
to the 18th century penmen who dedicated so
much of their lives to their endeavors,” he says,

> >
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“and, of course, to create the most dramatic and
elegant formal script I could to honor their amazing
talent.”

Lipton deserves the accolades for this quantum
leap, of course. But Lipton is the first to
acknowledge that he had help. OpenType
technology, in specific, was essential to the
transformation.

“Bickham Script Pro would not be the successful
design it is without its built-in technology,” Lipton
says. “It was the only path to making the font
everything it could be”

FroM OBSCURITY TO UBIQUITY

And the “everything it could be” is vast, which

in turn has resulted in its broad use in all kinds

of formats, from elegant menus to irony-laden
online banners. Although Lipton has peace of
mind knowing that his font met the lofty ideals of
his favorite masters, perhaps his final satisfaction
comes from its ubiquity.

“Seeing it in use everywhere I go makes me feel all
the hard design work was worth it =

Kevin Peaslee is a creative director at Axis41 and a
writer with almost two decades of experience.
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From elegant menus to
irony-laden designs,
Bickham is everywhere.
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#SCOOP: f_,. AR - You're on an airplane and
[IEXCITING NEWS FROT s ' .

i you've got three hours to kill.
You've already seen the mediocre
movie that'’s playing.

And without Internet access, you can't watch any
streaming videos from your laptop. What will you do
for entertainment? Play another round of solitaire
on your computer? Read every page of the SkyMall
catalog?

Soon, your options will expand. In April 2007, Adobe
L — previewed its new Adobe® Media Player software.

g This customizable, cross-platform player supports
LS : both downloaded and streamed media. It lets
viewers watch their favorite shows, virtually anytime,

anywhere. And it helps content businesses create new
ways to deliver high-quality content
and advertising.

NEW WAYS TO PLAY

THE ADOBE MEDIA PLAYER DELIVERS INNOVATIVE WAYS o ,_ i !_:J ADOBE MEDIA PLAYER

FOR BRANDS TO CONNECT WITH AUDIENCES.

BUILT-IN CREATIVE OPPORTUNITIES

For audiences, it's a whole new way to enjoy video
content. For creatives, it's a whole new way to
connect with viewers. The opportunities for branding,
advertising, and promotion are built right in to

the Adobe Media Player—and they can even be
synchronized with the video's content.

The player offers a variety of customization

opportunities right within the application, like product

placement using a hotspot. Other examples include

program or network-specific logos, banners, overlay

"bugs”and in-line video ads—all of which can be easily

incorporated into the main video content. “Advertising

in this new format can be as bold or subtle as you

want to make it says Jen Taylor, Group Product

Manger of Adobe Media Player. u

[
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http://www.adobe.com/go/amp
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* The player can be customized
to match the brand or theme
of whatever video is currently

playing.

LYPD
2ERL SEIN

DYNAMIC, CUSTOMIZABLE ADVERTISING

With its viewer-centric dynamic advertising, users can
actually tailor the ads they see by setting optional
anonymous preferences. And content publishers

can leverage this information to gain valuable usage
data, including when and how often a video has

been viewed, where the viewer starts and stops the
video, which videos they choose to remove from their
collection, and the number of advertising impressions
each video generates.

The player itself can also be customized to match the

brand or theme of whatever video is currently playing.

A show's identity—or a brand's logo—can appear
as a background visual on the player, and in any of
the available banner locations. These opportunities

[
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k Opportunities for customization
put branding and advertising at
the forefront of the viewer's
experience.

for customization, combined with new ways to bring
interactive banners and contextual ads to a media
player, put branding and advertising at the forefront of
the viewer's experience. Meanwhile the player’s user
interface works simply and subtly at the top of the
screen.

SIMPLE CONTENT CREATION

Whether you're developing a video program, creating
an ad campaign related to that program, or both, the
Adobe Media Player helps you get your content up and
running. If you have experience delivering content for
the Flash Player and have created web banners, you
have most of the skills and tools required.

"Now, you don't need an army of coders to create
media player content,”says Taylor. Featuring tight

>
i = 7 POSTERS THAT PROVOKE
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k Users can actually tailor the ads
they see by setting optional
anonymous preferences.

integration with Adobe Creative Suite 3 products—
including Adobe® Premiere® Pro CS3 and After Effects®
(CS3—Adobe Media Player empowers creatives to

get to work quickly, without days of ramp-up time on
new tools. And with support for H.264 encoded video
and standard advertising graphics formats, it's easy to
leverage existing content.

START PLAYING TODAY

The Adobe Media Player is now available as a public
pre-release, so you can experiment with the new
format—and share your feedback with the Adobe
engineering team. The full version of the Adobe Media
Player is expected to ship early in 2008. =
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‘Advertising in this new
format can be as bold or
subtle as you want to make it

O

DOWNLOAD THE BETA RELEASE
VERSION OF ADOBE MEDIA PLAYER
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INSERT ADS, EARN MONEY

With Ads for Adobe PDF, you can earn money by including ads in your PDF content. Adobe has
partnered with Yahoo! to provide ads across a broad range of categories to match any content.
Try the beta release today.

SPECIAL OFFERS

Access free Adobe Flash training.
When you buy Adobe Creative Suite 3
Design Premium or Web Premium

before February 29.

Find out more.

FONT OF
KNOWLEDGE

S T T EE R P —

g e e e 1 e B TN
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Adobe Bridge Home
Discover tips and tutorials
for all your favorite Adobe
products in Adobe Bridge
Home, accessible from any
Creative Suite 3 application.

Note: You must have Bridge
version 2.1 or higher to use
this link. Get it now. Mac or
Windows.

Or, you can access Adobe
Bridge Home by launching
and choosing File > Browse
from any Adobe Creative
Suite 3 application.

ADOBE DESIGN ACHIEVEMENT
AWARDS: CALL FOR ENTRIES

This global competition celebrates the world’s most talented creative arts
and technology students, from graphic design and photography to digital
film and animation. Enter the competition—and kickstart your creative
career. Find out more and enter.

INDUSTRY EVENTS

Adobe Creative Suite 3 Photoshop World

Events and Activities Apr. 2-4, Orlando, Florida
Mobile World Congress NAB Show

Feb. 11-14, Barcelona, Spain Apr. 14-17, Las Vegas, Nevada
SXSW Interactive

Mar. 7-11, Austin, Texas u )
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Discover and download great add-ons for your favorite Adobe software
products. We've collected some top customer picks from Adobe Exchange—
all available now as free or inexpensive downloads.

Al

ADOBE°® ILLUSTRATOR®
SWIRLY CURLS

Foliage, vines, and leaves—
in all their swirly, curly,
vector glory.

Download

ADOBE® PHOTOSHOP®
TEXT STYLES

Make simple text sparkle.
This quick Layer Styles tutorial
shows you how.

Download

ADOBE® AFTER EFFECTS®
BG RENDERER

Keep on multitasking. This script
renders in the background while
you work on other things.

Download

ADOBE° INDESIGN®
PHOTO CUBE

Open this template, drop
in six photos, and get your
glue stick ready.

Download

ADOBE®FLASH®
PANORAMA PLAYER
Create 360 degree panoramic

splendor— just by copying
files into Flash.

Download

“VERY, VERY COOL. NO QUICKTIME
CONTROL TO LOAD, JUST PLAIN FLASH.”

—ADANKERO04, OCTOBER 16, 2007
ADOBE EXCHANGE REVIEW
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http://www.adobe.com/cfusion/exchange/index.cfm?event=extensionDetail&loc=en_us&extid=1304521
http://www.adobe.com/cfusion/exchange/index.cfm?event=extensionDetail&loc=en_us&extid=1046612
http://www.adobe.com/cfusion/exchange/index.cfm?event=productHome&exc=21&loc=en_us
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SET YOUR ART IN MOTION

These three simple tips make it easier

to bring flat art to animated life.

These days, static art and design needn't stay flat on
a page. Whether it's turning a series of digital images
into a simple GIF animation or creating a complex
multimedia experience that combines still imagery,
motion, and sound, new technology is making the
process easier than ever before. And with these quick
tips, you can start getting your assets in motion.

Import Adobe lllustrator

TIP files into Flash.
There are two simple ways to import Adobe Illustrator
CS3 files into Adobe Flash CS3 without losing any of
your artwork data.

1. Copy and paste your Illustrator files right into Flash.

Go to Flash > Preferences and use the Al File Importer
to specify how the artwork should be pasted in: as

editable text, vector outlines, or bitmaps. You can even

create movie clips when you import from Illustrator.

ADOBE MAGAZINE FOR CREATIVE PROFESSIONALS

o J“}.. o

2, Import native Adobe lllustrator files into your Flash
document. Simply save your document as a regular
lllustrator file, go to Adobe Flash, and select File >
Import > Import to Stage. Then choose your lllustrator
file and specify exactly which Illustrator layers and
objects should be imported.

Watch the video tutorial.

m Create animated GIFs in

Adobe Photoshop.
There are two simple methods for creating animated
GIFs in Adobe Photoshop.

1. Create frame-based animations. In the Animation

palette, click"Make Frames from Layers! Underneath

each frame, select the number of seconds to hold for
each frame. Then, just hit the play button.

2, Use the timeline technique. In the animation palette,
go to Document Settings and set the Duration and
Frame Rate for the number of seconds to hold for each

Once you've created a basic motion tween using
one of these methods, you can change its shape,
color, scale, and more.n

frame. Select the frames you want to animate and Watch the video tutorial.
choose “Make Frames from Layers” Then, just select the
space bar key to play the animation. ~ ~
Watch the video tutorial.
MORE MOTION TIPS

m Create animations in Adobe Flash Discover more tutorials and tips in Adobe
using motion tweens. Bridge Home, accessible from any Adobe

Motion tweening is a simple way to make an animation Creative Suite 3 application.

from a symbol on a layer. After you've created a symbol _ )

to animate and created keyframes on your Adobe

Flash timeline, you can select the frames between your

keyframes to create a motion tween. Simply go to the

Properties panel, access the Tween drop-down, and

select Motion. Or you can right-click anywhere between

the two frames and select “Create Motion Tween!
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RATE THIS ISSUE

What did you love about this issue? What would you love to
change? Take a moment to rate this issue’s stories, design, and
navigation. You can even send a quick letter to the editor.

We read every last bit of feedback, so go ahead
and share your thoughts. We're listening.

g )

You will be directed to an external website
to submit your feedback.

- By

YOUR LETTERS

KILLING IN THE NAME OF ART?
Any real artist would not have
“extracted the whirligig insect

and preserved it No it was KILLED
because the “artist” (Revell) decided
it wasn't worth the effort of creating
his own sculpture, showing a real
disrespect for the creature he

finds so amazing. And Flach’s fetal
horse... DUH. I am seeing a lot of
senseless use of animal life all in
the name of art and really all about
money.

BarBara Menkes
New York, NY

Tim Flach responds:

As a photographer | hunt, but | do
not killl The specimens were part of
a decades-old scientific collection
at Cambridge University. The image
concerned was taken from a series
of work exploring equine embryo
development. | appreciate that this

work might be uncomfortable for
viewers but | also feel that it was a
vital part of my Equus project, which
explores our significant relationship
with the horse through domestication
and science.

Tim Flach, Photographer
London, England

GRAVITY-DEFYING BATS

In the Issue 3 “Natural Synthesis”
article, | find photographer Tim
Flach's choice to invert his bat
images to be misled. These photos
were made with great regard for
clarity, resolution, accuracy and
realism. Turning them upside
down is just plain incongruent.
The photographer is an obvious
technician, but following the
impulse to rotate the photos 180
degrees does not magically make
them art. Indeed, they may have
been more artistic prior to this
disparaging offense.

| enjoy Adobe Magazine and am
especially interested in watching
the transformation of the interface
from issue to issue. As a former
disbeliever in the on-screen
magazine format, | am slowly
coming around. Of course, that is

ADOBE MAGAZINE FOR CREATIVE PROFESSIONALS

happening thanks to the evolution
of the medium and people like you
at Adobe pushing the envelope. |

look forward to seeing what's next.

Thom Westergren,
Graphic Designer
Denver, Colorado

INTERACTIVE PDF TECHNIQUES
| found a great design: your

mag. | am myself an expert user

of InDesign and very fond of
interactive PDFs. It's difficult to find
those easy and great techniques for
user experiences in other PDFs. So,
congratulations on your design. Un
saludo y gracias.

Cristian Eslava,
Graphic Designer, Ceslava.com
Seville, Spain

A LITTLE LOVE

Hi there, WE LOVE THE MAG! It is

full of inspiration for designers like
myself who want to experiment
with cutting-edge graphic design
and learn new mixed media
techniques using the Creative Suite.

Can you tell me how the page
number tabs on the right side

are made? We currently have
Adobe Creative Suite 2 (will be
upgrading in the New Year), but
we're unsure on how to go about
creating interactive PDFs, any
links to show me how?

W.S. LAU,
Web Designer, Websense
Berkshire, UK

Adobe Magazine responds:
Thanks for your interest! Check out
this Adobe Design Center tutorial on
creating interactive PDEFs.

A LOT OF CREATIVITY

Love what you Adobe guys/

gals have done and do! Bravo/a!
Having fled to New Mexico from
California at the end of the
dot.com collapse, you folks
remain one of the few
connections | have with creativity
in the workplace. Adobe Magazine,
with its great interviews and art,
seems to be my only connection
to my former California life. Thanks
for being such a great resource!

Mary M. Hamel,
Technical Writer, IHS/NPA
Albuquerque, New Mexico
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Adobe Magazine would like to thank Ateliergemeinschaft
Gerwin Schmidt for their contributions to this issue. “A large
part of our work is to attain the viewer’s attention, surprise
him, and steer his emotions,” says designer Gerwin Schmidt.
“Therefore we have to disturb him sometimes. Sometimes,
we have to make noise. Sometimes we have to whisper.”
Schmidt, founder of Ateliergemeinschaft Gerwin Schmidt, has
been capturing the attention of audiences for 15 years.
He studied graphic design at Kassel University and visual
communication at design college HfG Karlsruhe. He currently
works in his Munich-based studio with junior partners Timo
Thurner and Philipp v. Keisenberg. The studio specializes
in poster design, book design and corporate design for
cultural and commercial clients. Now a professor himself,
Schmidt teaches in the Visual Communication Department at
the State Academy of Art and Design Stuttgart. He also serves
as a guest lecturer and instructor at poster workshops and
graphic design events across Europe.

Software used to create this issue of Adobe Magazine includes: Adobe
InDesign CS3, Illustrator CS3, and Photoshop CS3. Fonts include: Bickham
Script Pro, DIN, Helvetica Neue, Myriad Pro, OCR B, and Trade Gothic.

Adobe, the Adobe logo, Adobe Premiere, After Effects, Bickham Script,
Creative Suite, Flash, Illustrator, InDesign, Photoshop, and Reader are
eitherregistered trademarks or trademarks of Adobe Systems Incorporated,
in the United States and/or other countries. Mac and Macintosh are
trademarks of Apple Inc., registered in the United States and other countries.
Windows, OpenType, and Vista are either registered trademarks or
trademarks of Microsoft Corporation in the United States and/or other
countries. All other trademarks are the property of their respective owners.

Copyright © 2008 Adobe Systems Incorporated. All rights reserved.
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